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Getting Started with Cisco UCS Director REST API

New and Changed Information

Overview

The following table provides an overview of the significant changes to this guide for the current release. The
table does not provide an exhaustive list of all changes, or of all new features in this release.

Table 1: New Features and Changed Behavior in Cisco UCS Director, Release 6.5

Feature

What's New

Where Documented

Code and status of REST API
response

Provided the REST API response
codes and its corresponding status.

How to Interpret the HTTP
Response, on page 18

Example: Adding a Cisco UCS
Manager UUID pool

Provided a sample XML-based
URL to add a Cisco UCS Manager
UUID pool.

Example: Adding a Cisco UCS
Manager UUID pool, on page 22

Example: Setup PXE Boot Task

Provided a sample XML-based API
URL to execute setup PXE boot
task.

Example: Setup PXE Boot Task,
on page 22

Why Use the REST API

The Cisco UCS Director REST API allows an application to interact with Cisco UCS Director,

programmatically. These requests provide access to resources in Cisco UCS Director. With an API call, you
can execute Cisco UCS Director workflows and change the configuration of switches, adapters, policies, and
other hardware and software components.

The API accepts and returns HTTP messages that contain JavaScript Object Notation (JSON) or Extensible
Markup Language (XML) documents. The JSON or XML payload contained in an HTTP message describes
amethod or managed object (MO) in Cisco UCS Director. You can use any programming language to generate
the messages and the JSON or XML payload.
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In RESTful APIs, the HTTP method specifies the action you want to perform and the URI specifies the

resource you want to access.

REST API uses the following HTTP methods to perform create, read, update, and delete (CRUD) operations:

HTTP Method

Description

GET

Retrieves the specified resource. GET is a read-only
operation that does not change the engine state.

* The HTTP GET operation must not have a
request body. If information is passed in a GET
request, query parameters must be used instead.

* Unless specified, the HTTP GET operation
returns the configured state. For example, an
HTTP GET operation of the global routing table
returns the dynamic run-time state.

POST

Submits the data to be processed by the specified
resource. The data to be processed is included in the
request body. A POST operation can create a new
resource.

* Every POST request must include a JSON body
containing a definition of the new resource.

* For a POST operation to create a new resource,
the location header in the HTTP response must
contain the complete URL to be used for
subsequent PUT, GET, and DELETE commands.

* The HTTP POST response to a create request
must have a 201 return code and a location
header containing the URI of the newly created
resource in the HTTP header.

PUT

Updates the specified resource with new information.
The data that is included in the PUT operation replaces
the previous data.

* The PUT operation cannot be used to create a
new resource.

* The request body of a PUT operation must
contain the complete representation of the
mandatory attributes of the resource in JSON
format.
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HTTP Method

Description

DELETE

Deletes a resource.

* If you delete a resource that has already been
deleted, a 404 Not Found response is returned.

* The HTTP DELETE operation must not have a
request body. If information is passed in a GET
request, query parameters must be used instead.

How to Use the REST API

To access the REST API browser through Cisco UCS Director, a valid Cisco UCS Director user account and
an API access key are needed. Cisco UCS Director uses the API access key to authenticate API requests. This
access key is a unique security access key code that is associated with a specific Cisco UCS Director user

account. For more information about how to generate an API access key, see Generating an API Access Key,

on page 4.

You must pass the REST API access key as a name:value header following standard HTTP syntax and semantic
rules. For example, a valid name:value header is X-Cloupia-Request-Key:
FY90ZZF1234567827902127273456FZ789. For more information about the API request header, see How to
Make a REST API Request, on page 12 and RFC2616 Header Field Definitions.

The REST API call can be made in one of the following ways:

* Cisco UCS Director GUI—Cisco UCS Director provides a developer menu option to offer the report
metadata and REST API Browser for developers. To access these features, enable the developer menu.
For more information about how to enable the developer menu, see Enabling the Developer Menu Options,

on page 8.

On enabling the developer menu, you gain access to the following features:

* Report Metadata—The report metadata enables you to view the REST API URL for every report
displayed in Cisco UCS Director. For more information about how to access Report Metadata, see

Accessing the Report Metadata, on page 10.

* REST API Browser—The REST API Browser is accessible from the Orchestration menu of Cisco
UCS Director. The REST API Browser provides API information and API code generation
capabilities that make it easy to see and work with all the available APIs, including both the REST
APIs and the Java APIs. For more information about how to access REST API Browser, see Using

the REST API Browser, on page 8.

* REST Client—The REST Client is a useful widget for parsing and viewing API requests and responses.
In this widget, you can enter a REST URL and apply an HTTP method such as POST, PUT, or DELETE
to the URL for data manipulation. The REST Client provides a simple user interface for entering a URL

to fetch data from the Cisco UCS Director server.

* If you are using Mozilla Firefox, download RESTClient from Add-ons for Firefox.

* If you are using Google Chrome, download Advanced REST Client from the Chrome Web Store.
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N

Note If you are logged in to Cisco UCS Director, use any supported web browser to
send API requests and get responses.

* Code—The Sample Java Code tab of the REST API Browser tab provides a code snippet that can be
used to automate the management services.

The Cisco UCS Director SDK binary downloaded from the software download area or the DevNet site
includes a sample project that can be used as a platform for executing client code.

Prerequisites

Before you start using the Cisco UCS Director SDK, make sure that:

* Cisco UCS Director is installed and running on your system. For more information about how to install
Cisco UCS Director, refer the Cisco UCS Director Installation Guide.

* The Cisco UCS Director SDK is installed on your system.

* You have Java Version 1.8 for your Java development environment.

N

Note  Youneed Java Version 1.6 if you have release 5.3 or earlier of Cisco UCS Director

* You have an API access key. For more information about how to generate an API access key, see
Generating an API Access Key, on page 4.

* You have a REST client to execute RESTful web services.

A

Note * If you are using Mozilla Firefox, download RESTClient from Add-ons for
Firefox.

* If you are using Google Chrome, download Advanced REST Client from
the Chrome Web Store.

Generating an APl Access Key

Procedure

Step 1 Log in to Cisco UCS Director.

Step 2 Hover the mouse over the user icon at the top right corner and choose Edit My Profile from the drop-down
list.

Step 3 On the Edit My Profile page, click Show Advanced Settings.
Step 4 To copy the value displayed in the REST API Access Key area, click Copy Key Value.
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Step 5

Step 6

Downloading and Installing Cisco UCS Director REST APl SDK Bundle .

Save the access key in a secure location, and use it in the API request header.

For more information about the API request header, see How to Make a REST API Request, on page 12.

If you want to change the API access key, click Regenerate Key.

After you generate a new key, the old key code is retired and you cannot use it.

Downloading and Installing Cisco UCS Director REST APl SDK Bundle

The Cisco UCS Director REST APl SDK Bundle

The Cisco UCS Director REST API SDK Bundle is part of the Cisco UCS Director REST API. In addition
to documentation such as the Cisco UCS Director REST API cookbook, the SDK Bundle provides examples
that you can use with the REST API. These examples include test cases and sample code that demonstrates
the use of the SDK classes.

The SDK Bundle is delivered in an archive file named ucsd-rest-api-sdk-v2.zip.

Installing the Cisco UCS Director SDK

Procedure

Step 1

Step 2

Step 3

Step 4

Download the digitally signed zip file (CuSD_SDK_BINARIES xxxxx_ SIGNED.zip) from the software download
area or the DevNet site.

Unzip the cucsp_SDK_BINARIES xxxxx SIGNED.zip file. You will get the cucsD SDK_BINARIES xxxxx.zip
file and other supporting digital signature files.

Unzip the cusd_SDk_BINARIES xxxxx.zip file. The following files appear:

®* cucsd_script code samples-x.x.X.x

® cucsd cloupia-script-bundle-x.x.x.x
® cucsd-open-auto-sdk-bundle-x.x.x.x
® cucsd-rest-api-sdk-bundle-x.x.x.x

® cucsd-sdk-javadocs-x.x.xX.X

®* UCSDhirector PSC.exe

Unzip the cucsd-rest-api-sdk-bundle-x.x.0.0.zip file. This expands and provides the
ucsd—rest—api—sdk—x.x.0.0.zipznulucsd—rest—api—sdk—javadocs—x.x.0.0.zipfﬂe&

Unzip the ucsd-rest-api-sdk-x.x.0.0.zip file.
The ucsd-rest-api-sdk-x.x.0.0 folder is created on the local drive.

This folder includes the following folders and files to assist you in developing applications with the REST
API:
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* 1ib—This folder contains the ucsd-rest-api-sdk-v2.0. jar file. This file is the archive of all
classes and libraries required for managing the Cisco UCS Director.

» src—This folder contains the example test cases and sample code. These tests cases and codes
demonstrate the use of the SDK classes in the ucsd-rest-api-sdk-v2.jar file. The sample code
is available in the src\com\cisco\cuic\api\examples folder.

* .classpath—This file indicates where to look for SDK classes and packages, to the Java Virtual
Machine (JVM) or Java compiler.

» .project—This file is used to import the SDK Bundle into the Eclipse IDE. This file is required for
development purposes. It is available at the top level of the archive.

* README . txt—This file contains lists of all components included in the SDK Bundle.
* rest-server.properties—This file contains the properties used by the examples in the

src\com\cisco\cuic\api\examples folder.

Step 5 UIlZip the ucsd-rest-api-sdk-javadocs-x.x.0.0.zip file.
The ucsd-rest-api-sdk-javadocs-x.x.0.0 folder is created on the local drive, and it contains:.
* Javadocs—This folder contains the Cisco UCS Director REST API Javadocs. The Javadocs cover all
classes provided with the SDK Bundle.
Step 6 Add the ucsd-rest-api-sdk-v2. jar file to the Java classpath when compiling and running the client
program. Use Java Version 1.8 to run the Cisco UCS Director SDK.

Note For Cisco UCS Director Releases 5.3 and previous releases, use Java version 1.6 to run the Cisco
UCS Director SDK.

Downloading the REST APl SDK Bundle

The Cisco UCS Director SDK binaries can be downloaded from the software download area or the DevNet
site. Alternatively, an admin user and an end user can download the SDK binaries from Cisco UCS Director.

Procedure

Step 1 To download the REST API SDK bundle as an admin user, complete the following steps:

a) Log in to Cisco UCS Director.
b) Choose Administration > Downloads.

The following files are displayed:
* REST API SDK—cucsd-rest-api-sdk-bundle.zip

» PowerShell Console—UCSDirector PSC.exe
* Open Automation SDK—cucsd-open-auto-sdk-bundle.zip

¢ Custom Tasks Script Samples—cucsd-cloupia-script-bundle.zip
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Step 2

¢) Choose the cucsd-rest-api-sdk-bundle.zip file.
d) Click Download to download the SDK bundle.

List of Deprecated APls .

To download the REST API SDK bundle as an end user, complete the following steps:

a) Log in to the Cisco UCS Director End User Portal.

b) On the menu bar, click Services.
¢) Click the Downloads tab.

The following files are displayed:

* REST API SDK—cucsd-rest-api-sdk-bundle.zip

* PowerShell Console—console.exe

d) Choose the cucsd-rest-api-sdk-bundle.zip file and click Download.
The file is downloaded to the default download location.

List of Deprecated APls

Developers are encouraged to migrate to the new API, instead of using the deprecated API.

Table 2: Deprecated and New APIs

Deprecated API

Supported Till

New API

userAPICheckFunds

Release 4.1

From Cisco UCS Director Release 5.x and later
releases, the UserAPICheckFunds API thatis
available in the userAPIGlobal folder is
deprecated. To check the available customer funds,
use the UserAPICheckFunds API in the
userAPIChargeBack folder.

userAPISubmitServiceRequest

Release 4.1

userAPIProvisionRequest

userAPISubmitServiceRequestCustom

Release 4.1

userAPIProvisionRequest

UserAPIProvisionRequestWithPortGroup

Release 4.1

userAPIVMWareProvisionRequest

userAPIGetWorkflows Release 4.1 userAPIGetWorkflowInputs
userAPIImportWorkflows Release 5.3

UserAPICreateAPICContainer Release 5.4

userAPIResetMyPassword Release 5.5 userAPIModifyLoginProfilePassword
userAPIResetUserPassword Release 5.5 userAPIModifyUserPassword
userAPIAddTierToContainerVM Release 5.5 userAPIAddTierToContainer
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Setting Up the Development Environment

Setting up the Environment for Using the REST API Through the GUI

Enable the developer menu option to access the REST API Browser and Report Metadata information in
Cisco UCS Director. The REST API Browser and Report Metadata features provide you with site-specific
API data.

The HTTP request code provided by the Report Metadata view yields immediate API service results. You
can use these options in every situation where you need API information.

The Cisco UCS Director REST API Browser provides API information and API code generation capabilities
that make it easy to see and work with all of the available APIs, including both the REST APIs and the Java
APIs.

To use REST API in the GUI, perform the following tasks:
* Enabling the Developer Menu Options, on page 8

* Using the REST API Browser, on page 8

* Accessing the Report Metadata, on page 10

Enabling the Developer Menu Options

Procedure

Step 1

Step 2
Step 3

Step 4

Before you begin

Obtain one or more user accounts that provide the same administrative access to data that your application
users will have. Your Cisco UCS Director administrator can explain the data access limitations associated
with different administrator and end-user roles. You may want multiple user accounts to test the user experiences
associated with different data accesses and security controls.

In Cisco UCS Director, hover the mouse over the user icon at the top right corner and choose Edit My Profile
from the drop-down list.

On the Edit My Profile page, click Show Advanced Settings.

Check Enable Developer Menu (requires re-login).

The REST API Browser is activated in the Orchestration page, and the Report Metadata option becomes
available in the report views.

Tip The Advanced area displays the REST API Access Key code for the account.

Click Close.

Using the REST API Browser

The Cisco UCS Director REST API Browser provides API information and API code generation capabilities
that assist and educate developers in the use of all available Cisco UCS Director APIs, including the
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Using the REST API Browser [

XML-formatted REST API and the Java API. The primary view lists the Task folders that contain the APIs.
The task names supply the categories under which the APIs are listed. For example, all the APIs pertaining
to NetApp ONTAP tasks and NetApp OnCommand tasks are available inside the folders with these names.

Note

Procedure

Step 1
Step 2

Step 3

Step 4

The access for XML-based version-2 APIs with the /api/v2 context is role-based. Service end users cannot
execute the GET Operations with these APIs. Also, service end users can perform the create, update and delete
operations using the REST API only if they can perform the same operation using the graphical user interface
of Cisco UCS Director. If these users cannot perform a create, update or delete operation in the user interface,
then they cannot perform these actions using the REST API either.

Before you begin

* Obtain one or more user accounts that provide the same administrative access to data that your application
users will have. Your Cisco UCS Director administrator can explain the data access limitations associated
with different administrator and end-user roles. You may want multiple user accounts to test the user
experiences associated with different data accesses and security controls.

* Enable the developer menu option for the session.

Choose Orchestration.
Click REST API Browser.

Click the right scroll arrow, if necessary, to view and navigate to REST API Browser menu item.

Open the task folder that contains the API you want to view.

Tip You can use the Search field at the top right corner to find a specific API if you do not know which
task folder it belongs to. Enter a word(s) that represents the API Resource, Operation, or Description
field to narrow your search. You can also use the other options on that menu bar, such as the Add
Advanced Filter, to find a specific APIL.

Double-click a row that contains an API resource and operation that is required.
The REST API browser screen displays the following:

» API Examples—Displays the API data for your selection and enables you to generate a sample XML.
Depending on the operation and resource that you have selected, this area might also include data entry
boxes that accept parameter values. If the data has to be chosen from a list of data, such as group list
available in Cisco UCS Director, the data is listed out in a table. Choose a data and click Select to generate
sample XML based on the data.

From the Server drop-down list, choose a server on wich the API has to be executed. Click Execute
REST API to view the response of the sample XML.

* Details—Provides more details about the API, including the API definition, input parameters, and output
parameters.
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» Sample Java Code—Provides sample code for the API.

Accessing the Report Metadata

Report Metadata enables you to view the API code used by Cisco UCS Director, including the API request
code for every report displayed in Cisco UCS Director. This code includes a complete URL that is ready to
paste into a browser to send the URL request to Cisco UCS Director. The immediate API responses provide
information for the developer. To see the API request code, navigate to a report and select Report Metadata.

Before you begin

* Obtain one or more user accounts that provide the same administrative access to data that your application
users will have. Your Cisco UCS Director administrator can explain the data access limitations associated
with different administrator and end-user roles. You may want multiple user accounts in order to test the
user experiences associated with different data accesses and security controls.

* Enable the Developer Menu option for the session.

Procedure

Step 1 In Cisco UCS Director, navigate to the page for which you want to see the API code.

For example, click Orchestration.

Step 2 On the Workflow page, click Report Metadata.
Step 3 In the Information screen, review the report context, report definition, API parameters, and REST API URL.

Setting up the Environment for Using the REST APl Through the REST Client

The REST Client provides a standalone client that parses and labels the API data in a useful and informative
way. You can also use any supported web browser to send API requests and get responses. Download a
supported REST Client in a web browser to execute the REST URLs.

* In Mozilla Firefox, download RESTClient from Add-ons for Firefox.

* In Google Chrome, download Advanced REST Client from the Chrome Web Store.

Using the REST Client, you can execute the JSON APIs and XML APIs.

The sample JSON-based API URL to retrieve all catalogs using the GET method:
http://<serverip>/ app/api/rest?formatType=json&opName=userAPIGetAllCatalogs&opData={}
The sample XML-based API URL to create a user using the POST method:
http://serverip/cloupia/api-v2/user

<cuicOperationRequest>
<payload>

<! [CDATA[

<AddUserConfig>
<userType>Admin</userType>
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<!-- Accepts value from the list: userGroupByType-->
<userGroup>1</userGroup>
<mspOrganization></mspOrganization>
<loginName>apiuser</loginName>

<!-- Accepts value from the list: password-->
<password>bGthbmRhc2E=</password>
<!-- Accepts value from the list: password-->

<confirmPassword>bGthbmRhc2E=</confirmPassword>
<userContactEmail>apiuser@cisco.com</userContactEmail>
<firstName>API</firstName>

<lastName>User</lastName>

<phone></phone>

<address></address>

</AddUserConfig>

11>
</payload>
</cuicOperationRequest>

The HTTP response of the user creation URL:

HTTP Response Code : 200

Response data

<?xml version="1.0" encoding="UTF-8" standalone="yes"?><cuicOperationResponse>
<Log><Messages>1</Messages><Message><TimeStamp>2015-08-28 06:55:17.240</TimeStamp>
<Severity>INFO</Severity><Text>User Admin Created Successfully</Text>
</Message></Log><operationStatus>0</operationStatus><response><AddUserConfigResponse>
<OUTPUT USER NAME>apiuser</OUTPUT USER NAME></AddUserConfigResponse></response>
<responseMap><entry><key>OUTPUT USER NAME</key><value>apiuser</value></entry>
</responseMap></cuicOperationResponse>

Setting up the Environment for Using the REST APl Through Code

N

Import the Cisco UCS Director SDK bundle as a Java project into the Eclipse IDE to execute the code in
Eclipse. For more information about how to import the Cisco UCS Director SDK bundle, see Importing the
SDK Bundle Project into the Eclipse IDE, on page 11. The code can be taken from the Sample Java Code
tab of the REST API Browser. For more information about how to access the REST API Browser, see Using
the REST API Browser, on page 8.

Note

The instruction for using the Cisco UCS Director SDK bundle in Eclipse is captured in the document. The
similar process is applicable for other IDEs but developers must figure out the details for themselves.

Importing the SDK Bundle Project into the Eclipse IDE

Procedure

Step 1

Step 2

Before you begin

Obtain the SDK Bundle archive and extract the contents to an appropriate folder.

In the Eclipse IDE, choose File > New > Java Project.
The Create a Java Project dialog box appears.

In the Project Name ficld, enter a name for the project.
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Step 3 Right click the project, and select Import.
The Import dialog box appears.
Step 4 Select File System and click Next.
Step 5 Click Browse and navigate to the folder where you have extracted the SDK Bundle.
Step 6 Click Finish.

The Eclipse IDE displays the SDK Bundle project on the Project Explorer tab.

How to Make a REST API Request

API clients use an HTTP request to interact with Cisco UCS Director. To pass the REST API access key,
each request must be associated with an HTTP header called X-Cloupia-Request-Key with its value
set to the current REST API access key. For information about how to generate the REST API access key,
see Generating an API Access Key, on page 4.

Requests made to the API have the following characteristics:

* Requests are sent over HTTP.

* Request must contain a valid URL in the one of the following formats:
* JSON Format

http://SERVER/app/api/rest?formatType=json&opName=operationName&opData=
operationData

where:

* SERVER—The IP address or the hostname of the Cisco UCS Director VM.

* formatType—The only supported format that is discussed here is JavaScript Object Notation
(JSON). Set this parameter value to json.

» opName—The API operation name associated with the request. For example,
userAPIGetMyLoginProfile or userAPIGetVMActionStatus.

» opData—Parameters (or arguments) associated with the operation. Cisco UCS Director uses
JSON encoding of the parameters. If no arguments are required for the operation, use {} as an
empty set. Before you send JSON data in a request, encode the URL by applying escape
characters as appropriate. For details about encoding the URL, see the RFC at
http://www.ietf.org/rfc/rfc1738.txt. For more information about JSON syntax and data types,
see http://en.wikipedia.org/wiki/JSON#Data_types.2C_syntax_and example. For information
about non-JSON formatted API requests, see Using the REST API Browser, on page 8.

A\

Note When passing parameters in the REST API URL request, you must pass the
parameters within the two single quotes (for example, param0: "CatalogName").
If the parameter value includes any punctuations, your session will get hanged
after validation.

« XML Format

http://server/cloupia/api-v2/group
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HTTP method: POST

<cuicOperationRequest>

<payload>

<! [CDATA[

<AddGroupConfig>
<groupName>TestGroup</groupName>
<groupDescription></groupDescription>
<parentGroup>0</parentGroup>
<groupCode></groupCode>
<groupContact>jbesail@cisco.com</groupContact>
<firstName></firstName>
<lastName></lastName>

<phone></phone>

<address></address>
<groupSharePolicyId></groupSharePolicyId>
<allowPrivateUsers>false</allowPrivateUsers>
</AddGroupConfig>

11>

</payload>

</cuicOperationRequest>

For REST API examples, refer the Cisco UCS Director REST API Cookbook.

Note

If the variable passed in the REST URL has special characters, the variable must be enclosed within single
quotes (') as shown in the following example:

Resource URL Format
/cloupia/api-v2/datacenter/{datacenter}/NetworkInventory/{networkInventoryID}/VLAN/{VLANID}

Resource URL

/cloupia/api-v2/datacenter/Default Pod/NetworkInventory/'172.29.195.215'/VLAN/VLANO80O

About Operations Data Parameters or Arguments

As the method and the API resource type are communicated through the opName, the operation parameters
must present any arguments that you want to designate a specific instance of the resource to be operated upon.

Operations Data Parameter Syntax

The following table shows examples of operations data parameter syntax in JSON format.

If the operation needs the following parameters How to represent in JSON
(opData)

No parameters {}

One parameter; integer (for example, 10) {param0:10}

One parameter: string (for example, cloud) {param0:"cloud"}

Two parameters: a string and an Integer {param0:"cloud",param1:10}
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L
Tip

If the operation needs the following parameters How to represent in JSON

(opData)

Two parameters: a string with null value and an {paramO:null,param1:10}

Integer

Three parameters {param0:"cloud",param1:"cloupia",param2:100}

Operation Data Parameter Examples
..&opData={paramO:"datacenter",paraml:"DataCenterl"”, param2:"STORAGE-ACCOUNTS-T51"

..&opData={param0:"Create NFS Datastore",paraml:{"list":[{"name":"Volume Size","value":100},
{"name":"Select Group","value":"14"}, {"name":"Select vDC","value":18}]},param2:212}

* param0—Name of the workflow being invoked through the REST APIL

* paraml—Input being passed to the workflow. If there is more than one input, separate the inputs
with commas and put two single quotation marks around the input names and values. If there
are no inputs, use the keyword null as the parameter value.

* param2—If this workflow is being invoked as a child workflow of another service request, use
the service request (SR) ID. If this workflow is not invoked as a child workflow, use —1. When
—1 is used, a new service request is created.

Cisco UCS Director provides many complete API requests, formatted as URLs and ready for you to
cut and paste into a browser. See Enabling the Developer Menu Options, on page 8.

Context Parameters

In the preceding example, paramo is used to specify the Cisco UCS Director context. The context data value
refers to one of the major domains managed by Cisco UCS Director, for example, global-services,
datacenter, OI storage_accounts. A list of the standard Cisco UCS Director contexts appears in API Request
Context Parameters, on page 16.

Report Parameters

The report parameter value is always the reportld. Typical reportlds include "STORAGE-ACCOUNTS-TS1",
"CPU-SO", "VOLUMES--X1", "NETWORK-USAGE-HO0", "PORT-SUMMARY-V50", and
"PRIVATE-CLOUD-FREE-STORAGE-S1". The reportld is typically the last parameter listed in an API request for
areport. So, if the context is specified by two parameters, the report parameter is often the third, param2. For
an extensive list of report names and reportlds, categorized by context, see List of Available Cisco UCS
Director Reports, on page 26.

Handle Special Characters in REST URL

The characters "&", "=", "+",",", and "$" are reserved special characters by URL standards. Hence, it is better
to avoid using them when data is part of the URL (like the JSON requests) instead of being sent as a payload.

In unavoidable circumstances, you can alternatively use their unicode formats:
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Special Character Unicode
& \u0026
= \u003D
+ \u002B
, \u002C
$ \u0024

For example, if the data to be passed in the REST URL is Business Operations & PMO. WSS, the special
character can be replaced with the unicode format and the data can be passed as Business Operations \u0026
PMO. WSS.

Few more examples:

App+App Data = App\u002BApp Data
area,street = area\u002Cstreet

50$ = 50\u0024

if x=y = if x\u003Dy

Sample API Request 1

The operation that requests a Login profile refers to the logged-in user, so there is no need for a
parameter. Most other operations need multiple arguments.

http://10.10.1.153/app/api/rest?formatType=json&opName=userAPIGetMyLoginProfilegopData={}

Response to Sample API Request 1

{ "serviceResult":{"userId":"jsmith","firstName":"John","lastName":"Smith","email":
"jsmith@example.com", "groupName":"Eng Group","role":"Regular"}, "serviceError":null,
"serviceName":"InfraMgr", "opName":"userAPIGetMyLoginProfile" }

Sample API Request 2

In this request for a report about a chassis for a data center, the operation requires three parameters,
which are typical for a report request.

http://172.17.9.142/app/api/rest?opName=userAPIGetTabularReport&opData=
{param0:"datacenter",paraml:"datacenter",param2:"UCS-CHASSIS-T50"}

Response to Sample API Request 2

{"serviceResult":
{"rows": [{"ID":"PHY-ACC;sys/chassis-2",
"Account Name":"PHY-ACC","DN":"sys/chassis-2",
"Serial Number":"1558","Model":"N20-C6508","Power State":"ok",

"Operation State":"accessibility-problem",

"Configuration State":"ok","License State":"license-ok","Servers":5,
"IO Modules":2,"PSUs":4,"Fan Modules":8,

"Vendor":"Cisco Systems Inc"}, {"ID":"UCSCirrus;sys/chassis-1",
"Account Name":"UCSCirrus","DN":"sys/chassis-1",

"Serial Number":"FOX1352GDX4", "Model":"N20-C6508",

"Power State":"redundancy-failed","Operation State":"power-problem",

Cisco UCS Director REST API Getting Started Guide, Release 6.5 .



Getting Started with Cisco UCS Director REST API |

. API Request Context Parameters

2
Tip

"Configuration State":"ok","License State":"license-ok","Servers":7,
"IO_Modules":2,"PSUs":4,"Fan Modules":8,
"Vendor":"Cisco Systems Inc"}, {"ID":"UCSM237;sys/chassis-1",

"Account_Name":"UCSM237","DN":"syS/chassis—l",

"Serial Number":"1557","Model":"N20-C6508","Power State":"ok",

"Operation State":"operable",

"Configuration State":"unsupported-connectivity","License State":"license-ok",
"Servers":6,"I0O Modules":2,

"PSUs":4,"Fan Modules":8,"Vendor":"Cisco Systems Inc"},

{"ID":"reallOS;sys/chassis—l","Account_Name":"reallOS",
"DN":"syS/chassis—l","Serial_Number":"FOX1352GDX4","Model":"NZO—C6508",
"Power State":"redundancy-failed",

"Operation State":"power-problem","Configuration State":"ok",

"License State":"license-ok","Servers":7,

"IO Modules":2,"PSUs":4,"Fan Modules":8,"Vendor":"Cisco Systems Inc"}],
"columnMetaData":null}, "serviceError":null, "serviceName":"InfraMgr",

"opName" :"userAPIGetTabularReport" }}

For advanced Cisco UCS Director API users, the code in the Report Metadata request for the data
center UCS-CHASSIS-T50 report gave the first parameter as paramo0:"23". In the request used in
Sample API Request 2, the context "datacenter" was substituted for the value "23" and the request
was successful.

API Request Context Parameters

Cisco UCS Director REST API operations that require parameters typically require the context as a parameter.
There are a few exceptions, notably the operations that pick the context from login information.

If you want to create an API request, you have two options for finding the correct context parameter value to
use:

* Find the correct context name string in the list of standard Cisco UCS Director contexts, and copy it into
the JSON parameter specification in your API request.

* In Cisco UCS Director, navigate to a report that represents the same report data that you want to request
through the API. Find the REST API URL in Report Metadata and use the context parameter(s) that you
find there.

Timesaver

N

If you find the URL code used to send a request in Cisco UCS Director, you can use some or all of that API
request data to create your own request.

Note

In some scenarios, you might want to use the English (human-readable) name string for the context value
rather than the numeral string value that is provided in the Report Metadata listing of the REST API URL.

Context Field Names and Corresponding Parameter Names

In the listing below, the first element is the name of the field; the second, in quotation marks, is the context
value that you should assign to the parameter representing the context. In most requests for reports, param0O
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provides the context. If another context parameter (param1) value is required, you can use the value provided
for this parameter in the Report Metadata listing of the REST API URL.

Administrative Contexts

* CONTEXT TYPE GLOBAL="global";

* CONTEXT TYPE GLOBAL ADMIN = "global admin";

* CONTEXT TYPE GLOBAL SERVICES = "global-services";
* CONTEXT TYPE CLOUD ="cloud";

* CONTEXT TYPE HOSTNODE = "hostnode";

* CONTEXT TYPE CLUSTER = "cluster";

End User Contexts

* CONTEXT TYPE GROUP ="group";

* CONTEXT TYPE VM ="vm";

* CONTEXT TYPE VDC ="vdc";

* CONTEXT TYPE SR ="servicerequest";

Data Center Contexts

* CONTEXT TYPE PHYSICAL DATACENTER = "datacenter";

NetApp Report Contexts
* CONTEXT TYPE STORAGE ACCOUNTS= " storage accounts";

* CONTEXT TYPE STORAGE FILERS =" netapp filer";

* CONTEXT TYPE STORAGE AGGREGATES =" storage aggregates";
* CONTEXT TYPE STORAGE VOLUMES = "storage volumes";

* CONTEXT TYPE STORAGE LUNS ="luns";

* CONTEXT TYPE STORAGE VFLIERS = "netapp v_flier";

UCS Report Contexts
« CONTEXT TYPE INFRA_COMPUTE UCSM_ACCOUNT=" ucsm";

* CONTEXT TYPE INFRA COMPUTE UCS FABRIC INTERCONNECT =" compute fbi";
* CONTEXT TYPE INFRA COMPUTE UCS CHASSIS =" compute_ chassis";

* CONTEXT TYPE INFRA COMPUTE UCS SERVER ="compute server";

* CONTEXT TYPE INFRA COMPUTE UCS SERVICE PROFILE = "service profile";
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* CONTEXT TYPE INFRA COMPUTE UCS PORT CHANNEL = "ucs_portchannel";
* CONTEXT TYPE INFRA_COMPUTE UCS ORGANIZATION = "ucs_org";

* CONTEXT TYPE INFRA COMPUTE UCS SERVICE PROFILE TEMPLATE =
"ucs_service-profile-template";

* CONTEXT TYPE INFRA COMPUTE UCS BOOT POLICY ="ucs_boot policy";

* CONTEXT TYPE INFRA COMPUTE UCS VNIC TEMPLATE = "ucs_vnictemplate";

* CONTEXT TYPE INFRA COMPUTE UCS MAC POOL = "ucs_mac";

* CONTEXT TYPE INFRA COMPUTE UCS UUID POOL ="ucs uuid";

* CONTEXT TYPE INFRA_COMPUTE UCS WWNN_POOL = "ucs_wwnn";

* CONTEXT TYPE INFRA COMPUTE UCS WWPN POOL ="ucs wwpn";

* CONTEXT TYPE INFRA COMPUTE UCS SERVICE PROFILE VHBA ="ucs sp vhba";
« CONTEXT TYPE_INFRA_COMPUTE_UCS_SERVICE PROFILE VNIC ="ucs_sp_vnic";

* CONTEXT TYPE INFRA COMPUTE UCS IOMODULE = "ucs_iomodule";

* CONTEXT TYPE INFRA COMPUTE UCS SERVER ADAPTER UNIT =
"compute server adapter unit";

Network Report Contexts
« CONTEXT TYPE INFRA_NETWORK_DEVICE="network_device";

* CONTEXT TYPE INFRA NET DEVICE NIK =" net device nlk";

* CONTEXT TYPE INFRA NET DEVICE FAB IC =" net device fab ic";

* CONTEXT TYPE INFRA NET DEVICE N5K="net device n5k";

* CONTEXT TYPE INFRA NETWORK DEVICE VLAN ="net device_vlan";

* CONTEXT TYPE INFRA NETWORK DEVICE VSAN="net device vsan";

* CONTEXT TYPE INFRA NETWORK DEVICE INTERFACE ="net device interface";

* CONTEXT TYPE INFRA NETWORK DEVICE PORT PROFILE ="net device port profile";
* CONTEXT TYPE INFRA NETWORK DEVICE ZONE ="net device zone";

* CONTEXT TYPE INFRA NET QOS POLICY="net device qos policy";

How to Interpret the HTTP Response
The following HTTP status codes are returned by Cisco UCS Director:
* 401 Unauthorized—The API key is not a valid key.

* 200 OK—Cisco UCS Director has processed the request. The actual status of the request is in the body
of the response.
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The Cisco UCS Director response body is in JSON format as determined by the FormatType parameter

specified in the API request.

Code and Status of an REST API Response

Code Status

0 SUCCESS

1 UNKNOWN_ RESOURCE
2 NOT_SUPPORTED

3 INTERNAL ERROR

4 FAILED

5 ALREADY_ EXISTS

6 INVALID INPUT

7 RESOURCE NOT _FOUND
8 INVALID REQUEST

Components of an APl Response

API Response Description Component Example (Success Scenario)
Component
serviceResult If the request succeeds, this "serviceResult":
result contains a set of {"userld”:"jsmith", ,
. "firstName":"John","lastName":"Smith",
narpe—value pairs or a JSON "email:"jsmith@example.con",
(ﬂnectorrepoﬂ. groupName" :"Eng Group", "role":"Regular"}
serviceError If the request succeeds, the "serviceError":null
serviceError is set to null. If the
operation fails, the serviceError
contains the error message.
serviceName Name of the backend service. | "serviceName":"InfraMgr"
The backend service is often set
to InfraMgr.
opName Name of the operation provided | "opName™: "userAPIGetMyLoginProfile™
in the request.

Example: APl Response in a Success Scenario
{

"serviceResult":{"userId":"jsmith","firstName":"John","lastName":"Smith",

"email":"jsmith@example.

won

com™, non

groupName" :"Eng Group",
"serviceName":"InfraMgr",

role":"Regular"},

"serviceError":null,
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"opName" :"userAPIGetMyLoginProfile"
}

Example: APl Response in a Failure Scenario

{ "serviceResponse":null,
"serviceError":"SERVICE CALL EXCEPTION: Service InfraMgr does not support operation test",

"serviceName":"InfraMgr", "opName":"test"

}

API Response (Service Result) Data Types

The service result (payload) sent in a response to a Cisco UCS Director REST API request is specified for
the operation. The service result can be an operation-specific set of name-value pairs, or it can be formatted
as a standard data type for this API, that is, as a report or a JSON object.

How to Use cURL Commands

cURL is a command line tool for getting or sending data using URL syntax. You can use the cURL command
to execute a REST API request.

The following sample shows how to execute the userAPISubmitWorkflowServiceRequest API
and pass the input values:

curl -v -X POST -H 'X-Cloupia-Request-Key:5CF4C115F0034B189616B2B8EBAOF220"

-g 'http://172.17.32.75/app/api/rest?formatType=json&opName=
userAPISubmitWorkflowServiceRequest&opData={param0:"TestWorkFlowFromAPI",paraml:
{"list":[{"name":"Al","value":"Hello"}, {"name":"A2", "value":"World"}]},param2:-1}"

The following sample shows how to pass the variable value with space in insecure mode:

curl --insecure -v -X POST -H 'X-Cloupia-Request-Key:C97B881CE6B94DFB930765F7AC408xxx"

-g 'https://172.31.234.127/app/api/rest?formatType=json&opName=
userAPISubmitWorkflowServiceRequesté&opData={param0:"AddUCSMvlanvl",paraml: {"1list":

[{"name" :"VLAN%20ID", "value":"500"}, {"name" : "VLAN$20DESC", "value" :"CURLvlantest"}]},param2:-1}"'

Note

\}

To run the command in secure mode, install the CA certificate (cacert) file in your system and use the cert
location in curl call using the —cacert curl option.

The following sample shows how to roll back a workflow:

curl --insecure -v -X POST -H 'X-Cloupia-Request-Key:C97B881CE6B94DFBI30765F7AC408xxx"
-g 'https://172.31.234.127/app/api/rest?formatType=json&opName=
userAPIRollbackWorkflow&opData={param0:140}"'

Note

The -g parameter disables the curl check for nested braces { } [ ]. By default, curl does not allow nested braces
in REST calls.
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Cisco UCS Director REST API SDK Bundle — Samples

When you download the SDK, you can find the sample Java code in the
ucsd-rest-api-sdk-v2/src/com/cisco/cuic/api/examples path.

Example: Retrieving VDCs in a Group Based on a Logged-in User

Procedure

Step 1

Step 2

When provisioning VMs, you have to view a list of VDCs available for a particular group and choose the
required VDC. To accomplish this, Cisco UCS Director has to identify the group to which the user belongs
to and retrieve a list of VDCs available for the group. Then, you can create the VDC on which the VM is
provisioned.

Create a workflow with the following REST APIs in sequence:

1. userAPIGetMyLoginProfile—Retrieve the profile of the logged in user to identify the group to which the
user belongs to.

2. userAPIGetAllVDCs—Retrieve a list of VDCs available in the user group.

3. userAPICreateVDC—Create a service request to choose a VDC on which the VM is provisioned.

Identify the group to which the user belongs to using the userAPIGetMyLoginProfile API.
Request:

/app/api/rest?formatType=json&opName=userAPIGetMyLoginProfile&opData={}

Response:
{"serviceResult":{"userId":"sdk","firstName":null, "lastName":null, "email":"xyz@test.com",
"groupName":"Default Group","groupId":1,"role":"Regular"}, "serviceError":null,
"serviceName":"InfraMgr", "opName" :"userAPIGetMyLoginProfile"}

In this example, the user sdk belongs to the DefaultGroup group.

Retrieve a list of VDCs in the user group using the userAPIGetAlIVDCs API.
Request:

/app/api/rest?formatType=json&opName=userAPIGetAl1VDCs&opData={}

Response:

{ "serviceResult":{"rows":[{"Cloud":"","vDC ID":1,"Group":"Default Group","vDC":"Default
vDC", "Type":"Standard", "Lock State":"Locked","Total VMs":82,"Active VMs":72,"Custom Categories":0,
"vDC Description":"","Approvers":"","Status":"Default vDC: Not for new provisioning",
"Tag":null},

{"Cloud":"VCenter","vDC ID":4,"Group":"Default Group", "vDC":"SDKcontl" ,"Type":"Container",
"Lock State":"Unlocked","Total VMs":2,"Active VMs":2,"Custom Categories":0,
"vDC_Description":"",

"Approvers":"","Status":"Error (s) :\nNo NIC configuration found.",
"Tag":null}],"columnMetaData":
null, "reportParams":{}}, "serviceError":null, "serviceName":"InfraMgr",

"opName" :"userAPIGetAl1lVDCs" }
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Step 3

Create a service request for choosing the VDC on which the VM is provisioned using the userAPICreateVDC
API. An approver approves the service request and the user is notified about the VM provisioning using this
VDC. The system policy, computing policy, network policy, storage policy, and the cost model applicable to
the VDC are selected. The number of days to wait before deleting an inactive VM is selected. A self-service
policy which defines the tasks or actions that can be performed on the VDC is selected.

Request:
/app/api/rest?formatType=json&opName=userAPICreateVDC&opData={param0: {"vdcName":"sdk",
"vdcDescription":"sdk vdc", "cloudName":"VCenter","groupName":1, "approverl":"",
"approver2":"",

"vdcSupportEmail":"", "vdcCustomerNoticationEmail":"", "systemPolicy":"Default System Policy",
"deploymentPolicy":"", "slaPolicy":"" , "computingPolicy":"VCenter - Default Computing
Policy",

"storagePolicy":"VCenter - Default Storage Policy", "networkPolicy":"VCenter - Default
Network

Policy","costModel":"", "isLocked":false,"isDeletable":true,"inactivityPeriodForDeletion":-1,
"selfServiceEndUserPolicy":""}}

Response:

{ "serviceResult":true, "serviceError":null, "serviceName":"InfraMgr",
"opName" :"userAPICreateVDC" }

Example: Adding a Cisco UCS Manager UUID pool

The following sample provides the XML-based API URL to add a Cisco UCS Manager UUID pool:

<cuicoperationRequest>

<payload>

<! [CDATA[

<ucsUuidPool>

<name>Test UUID Pool</name>
<descr>Test UUID Pool</descr>
<prefix>other</prefix>
<otherPrefix>00000000-0000-0000<otherPrefix>
<accountName>ucsm-248</accountName>
<org>org-root</org>
<firstMACAddress>0000-000000000001</firstMACAddress>
<size>1</size>

</ucsUuidPool>

11>

</payload>

In this example, ensure that you provide the following details:

* <prefix>—~Enter either derived or other.

* <org>—The org must follow the format: org-dn. Where, dn is domain name.

Example: Setup PXE Boot Task

The following sample provides the XML-based API URL to execute setup PXE boot task:

<cuicOperationRequest>
<operationType>SETUP PXE BOOT</operationType>
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<payload>

<! [CDATA[

<SetupPXEBoot>

<!-- Accepts value from the list: NetworkBootManagerList-->
<netwotkBootManager>PXE</netwotkBootManager>
<osType>ESXi6.0</osType>
<serverMACAddress>dd:cc:ff:ff:cc:cc</serverMACAddress>
<!-- Accepts value from the list: IPConfigType-->
<IPConfigType>Static</IPConfigType>
<serverIPAddress>24.45.45.56</serverIPAddress>
<serverNetMask>255.255.255.0</serverNetMask>
<serverHostname>esxi</serverHostname>
<serverGateway>24.45.45.1</serverGateway>
<serverNameserver></serverNameserver>
<manageMentVlanID>0</manageMentVlanID>

<!-- Accepts value from the list: password-->
<rootPassword>cloupial23</rootPassword>
<timeZone>Africa/Abidjan</timeZone>
<additionalParameterList>

<AdditionalParameter>

<paramName>test</paramName>
<paramValue>123</paramValue>
</AdditionalParameter>

</additionalParameterList>
</SetupPXEBoot>

11>

</payload>
</cuicOperationRequest>

Example: Adding a Storage Policy

The following sample provides the XML-based API URL to add a storage policy with the connectivity type
as Simple:

<ucsStoragePolicy>

<policyName>Storage Policyl</policyName>
<policyDescription>Test Storage Policy</policyDescription> <ucsAcctName>UCSM 70</ucsAcctName>
<orgName>org-root</orgName>
<connectivityType>Simple</connectivityType>
<wwnnPool>node-default</wwnnPool>
<noO0fVhba>0</no0fVhba>
<vHBAOName>fc0</vHBAOName>
<VSAN>VSAN-EST</vSAN>
<vHBAlName>fcl</vHBAlName>

<VSAN FI B>VSAN-Add</vSAN FI B>
<sanConnPolicy></sanConnPolicy>
</ucsStoragePolicy>

The following sample provides the XML-based API URL to add a storage policy with the connectivity type
as Use SAN Connectivity Policy:

<ucsStoragePolicy>

<policyName>Storage Policy3</policyName>

<policyDescription>Test Storage Policy</policyDescription> <ucsAcctName>UCSM 70</ucsAcctName>
<orgName>org-root</orgName>

<connectivityType>Use SAN Connectivity Policy</connectivityType>
<wwnnPool>node-default</wwnnPool>

<noO0fVhba>0</no0fVhba>

<sanConnPolicy>Test</sanConnPolicy>

</ucsStoragePolicy>
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Define the connectivity type for adding a storage policy.

» connectivity Type—Choose one of the following as the connectivity type: Expert, Simple, No vHBAs,
Hardware Inherited, and Use SAN Connectivity Policy. Set the <noOfVhba> as zero when you chose
the connectivity type as Simple or Use SAN Connectivity Policy.

Example: Adding a Network Policy

The following sample provides the XML-based API URL to add a network policy with the connectivity type
as Use LAN Connectivity Policy:

<cuicOperationRequest>

<payload>

<! [CDATA[

<ucsNetworkPolicy>

<vNICOLabel></vNICOLabel>

<vNIClLabel></vNIClLabel>

<policyId></policyId>

<!--Mandatory field. The length of the ID must be lesser than or equal to 16 characters.
The ID field accepts alpha-numeric value and special characters ( , -, ., ,).-=->
<policyName>Net-Test</policyName>
<policyDescription></policyDescription>

<!--Mandatory field.-->

<accountName>UCSM-70</accountName>

<!--Mandatory field.-->
<orgDn>org-root/org-Org-GUReg/org-Org-UGBP2</orgDn>
<dynVNICConnectionPolicy></dynVNICConnectionPolicy>
<!--Mandatory field.-->

<connectivityType>Use LAN Connectivity Policy</connectivityType>
<lanConnPolicy>LAN CONN POL</lanConnPolicy>

<!--Mandatory field.-->

<expertNoOfVnics>0</expertNoOfVnics>

</ucsNetworkPolicy>

11>

</payload>

</cuicOperationRequest>

Define the connectivity type for adding a network policy.

* connectivity Type—Choose one of the following as the connectivity type: Expert, Simple, No vNICs,
Hardware Inherited, and Use LAN Connectivity Policy. Set the <expertNoOfVnics> as zero when you
chose the connectivity type as Use LAN Connectivity Policy.

Example: Modifying a LAN Port Channel

The UcsLanPortChannel (UPDATE) API enables you to perform the following actions:
* edit—To edit the flowCtrlPolicy, adminSpeed, and name.
* addports—To add a new port to an existing lanport channel.
* enableport—To enable all the ports attached to the respective lanport channel.

» disableport—To disable all the ports attached to the respective lanport channel.

The following samples provides the XML-based API URL to execute the above mentioned actions:
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edit

<cuicOperationRequest>

<payload>

<! [CDATA[

<ucsLanPortChannel>
<accountName>ucsm-70</accountName>
<adminSpeed>1gbps</adminSpeed>
<flowCtrlPolicy>Flow Contrl</flowCtrlPolicy>
<switchId>A</switchId>
<name>PC01</name>
<portId>1</portId>
<apiAction>edit</apiAction>
</ucsLanPortChannel>

11>

</payload>

</cuicOperationRequest>

addports

<cuicOperationRequest>

<payload>

<! [CDATA[

<ucsLanPortChannel>
<accountName>ucsm-70</accountName>
<switchId>A</switchId>
<name>PC01</name>
<portId>001</portId>
<apiAction>addPorts</apiAction>
<portList>
<accountName>ucsm-70</accountName>
<slotId>1</slotId>
<portId>18</portId>

</portList>

</ucsLanPortChannel>

11>

</payload>

</cuicOperationRequest>

enableport

<cuicOperationRequest>

<payload>

<! [CDATA[

<ucsLanPortChannel>
<accountName>ucsm-70</accountName>
<switchId>A</switchId>
<name>PC01</name>
<portId>1</portId>
<apiAction>enablePort</apiAction>
</ucsLanPortChannel>

11>

</payload>
</cuicOperationRequest>

disableport

<cuicOperationRequest>

<payload>

<! [CDATA[

<ucsLanPortChannel>
<accountName>ucsm-70</accountName>
<switchId>A</switchId>
<name>PC01</name>
<portId>1</portId>
<apiAction>disablePort</apiAction>
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</ucsLanPortChannel>

11>
</payload>
</cuicOperationRequest>

List of Available Cisco UCS Director Reports

In the following table, reports are grouped by context. The same report (with the same reportID) may be used
for different contexts, and so may appear in multiple locations in this list.

\}

Note Report IDs are always single strings without character spaces. Because some of these strings are very long,
they are broken across multiple lines within individual table cells below. If you perform an electronic search
for a full, exact reportld string, it may not return a result because the break inserts a character space; search
instead for a short unique string contained within the full reportld character string.

Context Report Name Report ID Report Type
AWS-EC2 cloud |Summary SUMMARY-V0 Summary
AWS-EC2 cloud |VMs VMS-TO Tabular
AWS-EC2 cloud |Images IMAGES-TO Tabular
AWS-EC2 cloud |Deleted VMs DELETED-VMS-TO0 Tabular
AWS-EC2 cloud |Memory MEMORY-S0 Bar Chart
AWS-EC2 cloud |VPU CPU-SO Bar Chart
AWS-EC2 cloud |Disk DISK-S0 Bar Chart
AWS-EC2 cloud |Trend: Memory TREND-MEMORY-HO Trend
AWS-EC2 cloud |Trend: CPU TREND-CPU-HO Trend
AWS-EC2 cloud |Trend: CPU Usage TREND-CPU-USAGE-HO Trend
AWS-EC2 cloud |Trend: Disk Reads & TREND-DISK-READS-& Trend
Writes (bytes) -WRITES-(BYTES)-HO
AWS-EC2 cloud |Trend: Disk Reads & TREND-DISK-READS-& Trend
Writes (ops) -WRITES-(OPS)-HO
AWS-EC2 cloud |Trend: Disk Reads & TREND-DISK-READS-& Trend
Writes (ops) -WRITES-(OPS)-HO
AWS-EC2 cloud |Trend: Network Usage TREND-NETWORK-USAGE-HO Trend
AWS-EC2 cloud | Groups with Most CPU GROUPS-WITH-MOST Tabular
Usage -CPU-USAGE-TO0
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Context Report Name Report ID Report Type

AWS-EC2 cloud | VMs With Most VMS-WITH-MOST -CPU-USAGE-TO | Tabular
Trend:CPU Usage

AWS-EC2 cloud | VMs With Over-Utilized | VMS-WITH-OVER- Tabular
CPU Usage UTILIZED-CPU-USAGE-TO0

AWS-EC2 cloud | VMs With Under-Utilized | VMS-WITH-UNDER Tabular
CPU Usage -UTILIZED-CPU-USAGE-TO

AWS-EC2 cloud | Volumes VOLUMES-X1 Tabular with

Actions
AWS-EC2 cloud | Snapshots SNAPSHOTS-X1 Tabular with
Actions

AWS-EC2 cloud |Summary SUMMARY-V1 Summary

AWS-EC2 cloud | SP Status SP-STATUS-TO Tabular

AWS-EC2 v CPU Usage (percent) CPU-USAGE-(PERCENT)-S0 Bar Chart

AWS-EC2 vm Network In NETWORK-IN-SO Bar Chart

AWS-EC2 vm Network Out NETWORK-OUT-S0 Bar Chart

AWS-EC2 vim Trend: CPU Usage TREND-CPU-USAGE-HO Trend

AWS-EC2 vm Trend: Disk Reads & TREND-DISK-READS Trend
Writes (bytes) -&-WRITES-(BYTES)-HO

AWS-EC2 v Trend: Disk Reads & TREND-DISK-READS Trend
Writes (ops) -&-WRITES-(OPS)-HO

AWS-EC2 vm Network Usage NETWORK-USAGE-HO Trend

catalog Deployability Assessment | DEPLOYABILITY-ASSESSMENT-T45 | Tabular

cloud vDCs VDCS-TO0 Tabular

cloud Events EVENTS-TO Tabular

cloud Number of Events by NUMBER-OF-EVENTS Bar Chart
Severity -BY-SEVERITY-S0

cloud Groups WIth Most Number | GROUPS-WITH-MOST Tabular
of VMs -NUMBER-OF-VMS-TO0

cloud vDCs With Most Number | VDCS-WITH-MOST Tabular
of VMs -NUMBER-OF-VMS-TO0

cloud vDCs With Most CPU VDCS-WITH-MOST -CPU-USAGE-TO0 | Tabular
Usage
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Context Report Name Report ID Report Type
cloud vDCs With Most Memory | VDCS-WITH-MOST Tabular
Usage -MEMORY-USAGE-TO0
cloud vDCs With Most Disk VDCS-WITH-MOST -DISK-USAGE-TO0 | Tabular
Usage
cloud, vin VM Action Requests VM-ACTION-REQUESTS-X0 Tabular with
Actions
compute chassis | Summary SUMMARY-V50 Summary
compute chassis | Servers SERVERS-T50 Tabular
compute chassis | Fan Modules FAN-MODULES-T50 Tabular
compute chassis |10 Modules I0-MODULES-T50 Tabular
compute chassis | Power Supply Units POWER-SUPPLY-UNITS-T50 Tabular
compute chassis | Events EVENTS-T50 Tabular
compute_fbi Summary SUMMARY-V50 Summary
compute fbi Power Supply Units POWER-SUPPLY-UNITS-T50 Tabular
compute fbi Fans FANS-T50 Tabular
compute fbi Ethernet Ports ETHERNET-PORTS-X50 Tabular with
Actions
compute fbi Fibre Channel Ports FIBRE-CHANNEL-PORTS-X50 Tabular with
Actions
compute fbi Trend: Ethernet Ports Total | TREND-ETHERNET-PORTS Trend
Kilo Bytes -TOTAL-KILO-BYTES
Transferred/Received -TRANSFERRED/RECEIVED-H50
compute_fbi Trend: Fibre Channel Ports | TREND-FIBRE-CHANNEL Trend
Total Kilo Bytes -PORTS-TOTAL-KILO-BYTES
Transferred/Received -TRANSFERRED/RECEIVED-H50
compute_fbi Trend: CPU Utilization TREND-CPU-UTILIZATION-H50 Trend
compute_fbi Trend: Memory TREND-MEMORY-H50 Trend
compute_fbi Events EVENTS-T50 Tabular
compute fbi port |Port Summary PORT-SUMMARY-V50 Summary
compute_server Local Disks LOCAL-DISKS-T50 Tabular
compute_server Memory Units MEMORY-UNITS-T50 Tabular
compute_server Processor Units PROCESSOR-UNITS-T50 Tabular
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Storage

-STORAGE-T9999

Context Report Name Report ID Report Type
compute_server Interface Cards INTERFACE-CARDS-X50 Tabular with
Actions

compute_server Service Request Details SERVICE-REQUEST-DETAILS-T50 | Tabular

compute_server Trend: MotherBoard Input | TREND-MOTHERBOARD Trend
Current Received -INPUT-CURRENT-RECEIVED-H50

compute_server Trend: MotherBoard Input | TREND-MOTHERBOARD Trend
Voltage Received -INPUT-VOLTAGE-RECEIVED-H50

compute_server Trend: MotherBoard TREND-MOTHERBOARD Trend
Consumed Power -CONSUMED-POWER-HS50

compute_server Trend: MotherBoard Sens | TREND-MOTHERBOARD Trend
10 Temperature -SENS-IO-TEMPERATURE-HS50

compute_server Trend: MotherBoard Sens | TREND-MOTHERBOARD Trend
Rear Temperature -SENS-REAR-TEMPERATURE-H50

compute_server Trend: Memory Unit TREND-MEMORY-UNIT Trend
Temperature -TEMPERATURE-H50

compute_server Trend: Processor Unit TREND-PROCESSOR-UNIT Trend
Current -CURRENT-H50

compute_server Trend: Processor Unit TREND-PROCESSOR-UNIT Trend
Temperature -TEMPERATURE-H50

compute_server Summary SUMMARY-V50 Summary

compute_server Events EVENTS-T50 Tabular

compute_server DCE Interfaces DCE-INTERFACES-T50 Tabular

_adapter_unit

compute_server HBAs HBAS-TS50 Tabular

_adapter unit

compute server | NICs NICS-T50 Tabular

_adapter_unit

custom_actions Add/Edit Tasks ADD/EDIT-TASKS-X46 Tabular with

Actions

datacenter Storage Accounts STORAGE-ACCOUNTS-T51 Tabular

datacenter Top 5 Volume Total-Used | TOP-5-VOLUME-TOTAL Tabular
Storage -USED-STORAGE-T9999

datacenter Top 5 Lun Total-Used TOP-5-LUN-TOTAL-USED Tabular
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Context Report Name Report ID Report Type
datacenter Summary SUMMARY-V51 Summary
datacenter Volumes: Total vs Used VOLUMES-TOTAL-VS-USED-S51 Bar Chart
datacenter LUNS: Total vs Used LUNS-TOTAL-VS-USED-S51 Bar Chart
datacenter Aggregates: Free vs Used | AGGREGATES-FREE-VS -USED-S51 | Pie Chart
datacenter UCSM Accounts UCSM-ACCOUNTS-X50 Tabular with
Actions
datacenter Chassis CHASSIS-T50 Tabular
datacenter Fabric Interconnects FABRIC-INTERCONNECTS-T9999 | Tabular
datacenter Server Pools SERVER-POOLS-T9999 Tabular
datacenter Summary SUMMARY-V50 Summary
datacenter Service Profiles SERVICE-PROFILES-T9999 Tabular
datacenter Processor Units PROCESSOR-UNITS-T9999 Tabular
datacenter Memory Units MEMORY-UNITS-T9999 Tabular
datacenter Local Disks LOCAL-DISKS-T9999 Tabular
datacenter 10 Modules I0-MODULES-T9999 Tabular
datacenter Managed Network MANAGED-NETWORK- Tabular with
Elements ELEMENTS-X52 Actions
datacenter VTP Status VTP-STATUS-TS2 Tabular
datacenter Private VLANs PRIVATE-VLANS-T52 Tabular
datacenter L2 Neighbors L2-NEIGHBORS-T52 Tabular
datacenter Port Profiles PORT-PROFILES-T52 Tabular
datacenter VM Network Details VM-NETWORK-DETAILS-T52 Tabular
datacenter Host Network Details HOST-NETWORK-DETAILS-T52 Tabular
datacenter VSANs VSANS-TS52 Tabular
datacenter VLANSs VLANS-X52 Tabular with
Actions
datacenter HP Accounts HP-ACCOUNTS-X50 Tabular with
Actions
datacenter DHCP Log DHCP-LOG-T50 Tabular
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Context Report Name Report ID Report Type
datacenter PXE Boot Requests PXE-BOOT-REQUESTS-X50 Tabular with
Actions
global Summary SUMMARY-V0 Summary
global Clouds CLOUDS-TO Tabular
global vDCs VDCS-TO Tabular
global Clusters CLUSTERS-TO Tabular
global VMs VMS-TO Tabular
global Host Node Status HOST-NODE-STATUS-TO0 Tabular
global Host Node Inventory HOST-NODE-INVENTORY-TO Tabular
global Resource Pools RESOURCE-POOLS-TO0 Tabular
global Events EVENTS-TO Tabular
global Images IMAGES-TO0 Tabular
global Deleted VMs DELETED-VMS-TO0 Tabular
global System Health SYSTEM-HEALTH-T30 Tabular
global Active VM Distribution ACTIVE-VM-DISTRIBUTION- Pie Chart
BY-CLOUD-S0
global Active VMs Public vs ACTIVE-VMS-PUBLIC-VS Pie Chart
Private By Clouds -PRIVATE-CLOUDS-S0
global Memory MEMORY-S0 Bar Chart
global CPU CPU-S0 Bar Chart
global Disk DISK-S0 Bar Chart
global Private Cloud Storage PRIVATE-CLOUD-STORAGE Pie Chart
Capacity -CAPACITY-S1
global Private Cloud Free Storage | PRIVATE-CLOUD-FREE-STORAGE-S1 | Pie Chart
global Private Cloud Used Storage | PRIVATE-CLOUD-USED-STORAGE-S1 | Pie Chart
global Storage Capacity Per STORAGE-CAPACITY-PER- Bar Chart
Storage Type STORAGE-TYPE-S1
global Used Storage Per Storage | USED-STORAGE-PER-STORAGE-TYPE-S1 | Bar Chart
Type
global Free Storage Per Storage | FREE-STORAGE-PER-STORAGE-TYPE-S! | Bar Chart
Type

Cisco UCS Director REST API Getting Started Guide, Release 6.5 .




. List of Available Cisco UCS Director Reports

Getting Started with Cisco UCS Director REST API |

Context Report Name Report ID Report Type

global Top 5 Datastores Most TOP-5-DATASTORES-MOST-USED-S1 | Bar Chart
Used

global Top 5 Datastores Least TOP-5-DATASTORES-LEAST-USED-S1 | Bar Chart
Used

global Number of Events NUMBER-OF-EVENTS-S0 Bar Chart

global Trend: Number of Host TREND-NUMBER-OF-HOST-NODES-HO | Trend
Nodes

global Trend: Memory TREND-MEMORY-HO Trend

global Trend: Storage Capacity, | TREND-STORAGE-CAPACITY, Trend
Used & Free -USED-&-FREE-H1

global Trend: CPU TREND-CPU-HO Trend

global All VMware Activity ALL-VMWARE-ACTIVITY-TO Tabular

global Summary SUMMARY-V1 Summary

global SP Status SP-STATUS-TO Tabular

global, cloud VMs Active vs Inactive VMS-ACTIVE-VS-INACTIVE-SO Bar Chart

global, cloud Trend: Number of VMs TREND-NUMBER-OF-VMS-HO0 Trend

global, cloud Trend: VM Additions & TREND-VM-ADDITIONS-& Trend
Deletions -DELETIONS-HO

global admin NetAppVolumesTable NETAPPVOLUMESTABLE-T9999 Tabular

global admin NetAppVFilerVolumes NETAPPVFILERVOLUMES Tabular
Table TABLE-T9999

global admin NetAppLunsTable NETAPPLUNSTABLE-T9999 Tabular

global _admin NetAppVFilerLunsTable |NETAPPVFILERLUNSTABLE-T9999 | Tabular

global admin NetAppFilersTable NETAPPFILERSTABLE-T9999 Tabular

global admin NetApplnitiatorGroups NETAPPINITIATORGROUPS Tabular
Table TABLE-T9999

global admin NetAppVFilerInitiator NETAPPVFILERINITIATOR Tabular
Groups Table GROUPSTABLE-T9999

global admin NetAppIPSpacesTable NETAPPIPSPACESTABLE-T9999 Tabular

global _admin NetAppVFilersTable NETAPPVFILERSTABLE-T9999 Tabular

global admin NetAppAggregatesTable | NETAPPAGGREGATESTABLE-T9999 | Tabular
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Context Report Name Report ID Report Type

global admin NetAppONTAPAccounts | NETAPPONTAPACCOUNTS Tabular
Table TABLE-T9999

global admin NetAppDFMAccounts NETAPPDFMACCOUNTS Tabular
Table TABLE-T9999

global admin NetAppDFMFiler Table | NETAPPDFMFILERTABLE-T9999 Tabular

global admin NetAppONTAPFiler Table | NETAPPONTAPFILERTABLE-T9999 | Tabular

global _admin NetAppONTAPvFilers NETAPPONTAPVFILERS Tabular
Table TABLE-T9999

global admin NetAppUnAssignedIP NETAPPUNASSIGNEDIPSPACES Tabular
SpacesTable TABLE-T9999

global admin NetApplnterfacesTable NETAPPINTERFACESTABLE-T9999 | Tabular

global admin NetAppVLANPhysical NETAPPVLANPHYSICALINTERFACES | Tabular
InterfacesTable TABLE-T9999

global admin NetApplnterfacesvFilers | NETAPPINTERFACESVFILERS Tabular
Assigned Table ASSIGNEDTABLE-T9999

global _admin NetAppDFMvFilersTable | NETAPPDFMVFILERSTABLE-T9999 | Tabular

global admin NetAppDfmVolume NETAPPDFMVOLUMEDATASET Tabular
DatasetTable TABLE-T9999

global admin NetAppDfmLUN NETAPPDFMLUNDATASET Tabular
DatasetTable TABLE-T9999

global admin NetAppDfmGroupTable | NETAPPDFMGROUPTABLE-T9999 | Tabular

global admin NetAppDfmProvision NETAPPDFMPROVISIONPOLICY Tabular
PolicyTable TABLE-T9999

global admin NetAppDfmStorage NETAPPDFMSTORAGESERVICE Tabular
ServiceTable TABLE-T9999

global _admin NetAppUnAssigned NETAPPUNASSIGNEDDATASET Tabular
DatasetTable TABLE-T9999

global _admin NetAppAssignedDatasetTable | NETAPPASSIGNEDDATASET Tabular

TABLE-T9999

global admin NetAppDatasetTable NETAPPDATASETTABLE-T9999 Tabular

global admin NetAppDatasetMember NETAPPDATASETMEMBER Tabular
LUN Table LUNTABLE-T9999

global admin NetAppReourcePoolTable | NETAPPREOURCEPOOLTABLE-T9999 | Tabular
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Context Report Name Report ID Report Type
global admin NetAppGroupAssigned NETAPPGROUPASSIGNED Tabular
VFilersTable VFILERSTABLE-T9999
global admin Provisioning Policies PROVISIONING-POLICIES-T48 Tabular
global admin Protection Policies PROTECTION-POLICIES-T48 Tabular
global _admin Storage Services STORAGE-SERVICES-T48 Tabular
global _admin vFiler Templates VFILER-TEMPLATES-T48 Tabular
global admin OnCommand Datasets ONCOMMAND-DATASETS-T48 Tabular
global admin OnCommand Groups ONCOMMAND-GROUPS-T48 Tabular
global admin Resource Pool RESOURCE-POOL-T48 Tabular
global admin UIMenultemTable UIMENUITEMTABLE-T9999 Tabular
global _admin UlOperationTable UIOPERATIONTABLE-T9999 Tabular
global admin Customer Organizations | CUSTOMER-ORGANIZATIONS-X23 | Tabular with
Actions
global admin Customer Organizations | CUSTOMER-ORGANIZATIONS-T23 | Tabular
global admin Customer Organizations | CUSTOMER-ORGANIZATIONS-T23 | Tabular
global admin MSP Organizations MSP-ORGANIZATIONS-X23 Tabular with
Actions
global admin MSP Organizations MSP-ORGANIZATIONS-T23 Tabular
global admin Login Page Branding LOGIN-PAGE-BRANDING-X23 Tabular with
Actions
global _admin Login Page Branding LOGIN-PAGE-BRANDING-T23 Tabular
global admin Login Users LOGIN-USERS-X23 Tabular with
Actions
global admin Login Users LOGIN-USERS-T23 Tabular
global admin Current Online Users CURRENT-ONLINE-USERS-X23 Other
global _admin Virtual Accounts VIRTUAL-ACCOUNTS-X22 Tabular with
Actions
global _admin Virtual Accounts VIRTUAL-ACCOUNTS-T22 Tabular
global admin Physical Accounts PHYSICAL-ACCOUNTS-X24 Tabular with
Actions
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global admin Physical Accounts PHYSICAL-ACCOUNTS-T24 Tabular

global _admin Catalog CATALOG-X40 Tabular with
Actions
global admin UcsOrganizationTable UCSORGANIZATION TABLE-T9999 | Tabular
global admin UcsServerTable UCSSERVERTABLE-T9999 Tabular
global _admin UcsServiceProfileTable UCSSERVICEPROFILE TABLE-T9999 | Tabular
global admin UcsServerPoolTable UCSSERVERPOOLTABLE-T9999 Tabular
global admin UcsBootPolicyTable UCSBOOTPOLICYTABLE-T9999 Tabular

global admin Data Centers DATA-CENTERS-X24 Tabular with
Actions
global _admin Data Centers DATA-CENTERS-T24 Tabular

global admin Storage Policy STORAGE-POLICY-X47 Tabular with
Actions

global admin Network Policy NETWORK-POLICY-X47 Tabular with
Actions

global _admin vHBA VHBA-X47 Tabular with
Actions

global admin vNIC VNIC-X47 Tabular with
Actions

global _admin Placement Policy PLACEMENT-POLICY-X47 Tabular with
Actions
global admin deviceZonesTable DEVICEZONESTABLE-T9999 Tabular

global admin Vendor Validated Designs | VENDOR-VALIDATED- Tabular with
DESIGNS-X24 Actions
global _admin HpServerTable HPSERVERTABLE-T9999 Tabular

global admin Reports Customization REPORTS-CUSTOMIZATION-X20 | Tabular with
Actions

global admin Amazon Deployment Policy | AMAZON-DEPLOYMENT-POLICY-X41 | Tabular with
Actions
global admin Amazon Deployment Policy | AMAZON-DEPLOYMENT-POLICY-T41 | Tabular

global _admin VMware Deployment VMWARE-DEPLOYMENT-POLICY-X21 | Tabular with
Policy Actions
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global admin VMware Deployment VMWARE-DEPLOYMENT-POLICY-T21 | Tabular
Policy
global admin Resource Allocation Policy | RESOURCE-ALLOCATION-POLICY-X21 | Tabular with
Actions
global admin Resource Allocation Policy | RESOURCE-ALLOCATION-POLICY-T21 | Tabular
global _admin Rackspace Deployment RACKSPACE-DEPLOYMENT-POLICY-X41 | Tabular with
Policy Actions
global _admin Rackspace Deployment RACKSPACE-DEPLOYMENT-POLICY-T41 | Tabular
Policy
global admin KVM Deployment Policy | KVM-DEPLOYMENT-POLICY-X41 | Tabular with
Actions
global admin KVM Deployment Policy | KVM-DEPLOYMENT-POLICY-T41 |Tabular
global admin VMware Network Policy | VMWARE-NETWORK-POLICY-X44 | Tabular with
Actions
global _admin VMware Network Policy | VMWARE-NETWORK- POLICY-T44 | Tabular
global admin Network Provisioning NETWORK-PROVISIONING- Tabular with
Policy POLICY-X44 Actions
global admin Network Provisioning NETWORK-PROVISIONING- Tabular
Policy POLICY-T44
global admin VLAN Pool Policy VLAN-POOL-POLICY-X44 Tabular with
Actions
global admin VLAN Pool Policy VLAN-POOL-POLICY-T44 Tabular
global admin Virtual Storage Catalog VIRTUAL-STORAGE- CATALOG-X43 | Tabular with
Actions
global admin Virtual Storage Catalog VIRTUAL-STORAGE- CATALOG-T43 | Tabular
global admin VMware Storage Policy VMWARE-STORAGE- POLICY-X43 | Tabular with
Actions
global _admin VMware Storage Policy VMWARE-STORAGE- POLICY-T43 | Tabular
global admin VMware Storage Policy VMWARE-SYSTEM-POLICY-X41 Tabular with
Actions
global admin VMware Storage Policy VMWARE-SYSTEM-POLICY-T41 Tabular
global admin VMware Computing Policy | VMWARE-COMPUTING- Tabular with
POLICY-X42 Actions
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global admin VMware Computing Policy | VMWARE-COMPUTING- Tabular
POLICY-T42
global admin KVM Computing Policy | KVM-COMPUTING-POLICY-X42 Tabular with
Actions
global admin KVM Computing Policy |KVM-COMPUTING-POLICY-T42 Tabular
global admin Cost Model COST-MODEL-X41 Tabular with
Actions
global _admin Cost Model COST-MODEL-T41 Tabular
global admin Storage Tier Cost Model | STORAGE-TIER-COST-MODEL-X41 | Tabular with
Actions
global admin Storage Tier Cost Model | STORAGE-TIER-COST- MODEL-T41 | Tabular
global admin OS License OS-LICENSE-X41 Tabular with
Actions
global admin OS License OS-LICENSE-T41 Tabular
global _admin Network Services Agents | NETWORK-SERVICES- AGENTS-X24 | Tabular with
Actions
global admin Discovered Devices DISCOVERED-DEVICES-X24 Tabular with
Actions
global admin Active Modules ACTIVE-MODULES-X26 Tabular with
Actions
global admin Active Modules ACTIVE-MODULES-T26 Tabular
global _admin Modules MODULES-X26 Tabular with
Actions
global admin Modules MODULES-T26 Tabular
global admin Module Snapshots MODULE-SNAPSHOTS-X26 Tabular with
Actions
global _admin Module Snapshots MODULE-SNAPSHOTS-T26 Tabular
global admin vmwareV SwitchTable VMWAREVSWITCH TABLE-T9999 | Tabular
global _admin portGroups PORTGROUPS-T9999 Tabular
global admin Workflows WORKFLOWS-X46 Tabular with
Actions
global _admin User VM Action Policy USER-VM-ACTION-POLICY-X46 Tabular with
Actions
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global admin Context Workflow Mapping | CONTEXT-WORKFLOW- Tabular with
MAPPING-X46 Actions
global admin Templates TEMPLATES-X46 Tabular with
Actions
global admin Workflow Schedules WORKFLOW-SCHEDULES-X46 Tabular with
Actions
global _admin Custom Approval Tasks CUSTOM-APPROVAL-TASKS-X46 | Tabular with
Actions
global _admin License LICENSE-X20 Tabular with
Actions
global admin tabularlov.system.advanced. | TABULARLOV.SYSTEM.ADVANCED. | Tabular
property.report PROPERTY.REPORT-T9999
global admin Change Records CHANGE-RECORDS-T25 Tabular
global admin Application Categories APPLICATION-CATEGORIES-X20 | Tabular with
Actions
global _admin System Tasks SYSTEM-TASKS-X20 Tabular with
Actions
global admin System Tasks SYSTEM-TASKS-T20 Tabular
global admin LDAP Integration LDAP-INTEGRATION-X23 Tabular with
Actions
global admin LDAP Integration LDAP-INTEGRATION-T23 Tabular
global admin Virtual Console Servers VIRTUAL-CONSOLE-SERVERS-X24 | Tabular with
Actions
global admin Triggers TRIGGERS-X46 Tabular with
Actions
global admin, vDC VDC-X45 Tabular with
group Actions
global admin, vDC Service Profiles VDC-SERVICE-PROFILES-X45 Tabular with
group Actions
global admin, Catalog CATALOG-T40 Tabular
group
group vDCs VDCS-T14 Tabular
group Port Groups PORT-GROUPS-X14 Tabular with
Actions
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group vFilers VFILERS-X15 Tabular with
Actions
group Servers SERVERS-X15 Tabular with
Actions
group Service Profiles SERVICE-PROFILES-X15 Tabular with
Actions
group Service Requests SERVICE-REQUESTS-X10 Tabular with
Actions
group Archived Service Requests | ARCHIVED-SERVICE- Tabular with
REQUESTS-X10 Actions
group Users USERS-X13 Tabular with
Actions
group VMs VMS-T14 Tabular
group Resource Limits RESOURCE-LIMITS-T13 Tabular
group Summary SUMMARY-V13 Summary
group Top 5 Failure Reasons TOP-5-FAILURE-REASONS-T10 Tabular
group Trend: Network Usage TREND-NETWORK-USAGE-H14 Trend
group Trend: CPU Usage TREND-CPU-USAGE-H14 Trend
group Trend: Disk Usage TREND-DISK-USAGE-H14 Trend
group Trend: Consolidated TREND-CONSOLIDATED- Trend
Resource Usage RESOURCE-USAGE-H14
group VMs Active vs Inactive VMS-ACTIVE-VS-INACTIVE-S13 Bar Chart
group VLANSs VLANS-X15 Tabular with
Actions
group Resource Accounting RESOURCE-ACCOUNTING-T12 Tabular
group Resource Accounting RESOURCE-ACCOUNTING-DETAILS-T12 | Tabular
Details
group Chargeback CHARGEBACK-T12 Tabular
group Resource Accounting RESOURCE-ACCOUNTING- Tabular
Details DETAILS-T85
group Chargeback CHARGEBACK-TS85 Tabular
group Current Month Summary | CURRENT-MONTH-SUMMARY-V12 | Summary
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group Previous Month Summary | PREVIOUS-MONTH-SUMMARY-V12 | Summary
group Current Month Cost CURRENT-MONTH-COST- Pie Chart
Summary SUMMARY-S12
group Previous Month Cost PREVIOUS-MONTH-COST- Pie Chart
Summary SUMMARY-S12
group Current Month Top 5 CURRENT-MONTH-TOP-5 Pie Chart
Applications -APPLICATIONS-S12
group Previous Month Top 5 PREVIOUS-MONTH-TOP-5 Pie Chart
Applications -APPLICATIONS-S12
group Trend: Budget Spending | TREND-BUDGET-SPENDING-H12 | Trend
group Trend: Total Cost TREND-TOTAL-COST-H12 Trend
group Trend: VM Cost TREND-VM-COST-H12 Trend
group Trend: CPU Cost TREND-CPU-COST-H12 Trend
group Trend: Memory Cost TREND-MEMORY-COST-H12 Trend
group Trend: Network Cost TREND-NETWORK-COST-H12 Trend
group Payment Information PAYMENT-INFORMATION-X10 Tabular with
Actions
group Customer Funds CUSTOMER-FUNDS-X10 Tabular with
Actions
group Resource Accounting RESOURCE-ACCOUNTING- Tabular
Details DETAILS-T10
hostnode Summary SUMMARY-V0 Summary
hostnode VMs VMS-TO Tabular
hostnode Events EVENTS-TO Tabular
hostnode Deleted VMs DELETED-VMS-TO0 Tabular
hp, datacenter ILO Servers ILO-SERVERS-X50 Tabular with
Actions
hp server Server NICs SERVER-NICS-T50 Tabular
hp server Server Memory SERVER-MEMORY-T50 Tabular
hp_server Server Processor SERVER-PROCESSOR-T50 Tabular
hp_server Server Slots SERVER-SLOTS-T50 Tabular
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HyperV cloud Trend: Number of Host TREND-NUMBER-OF- HOST Trend
Nodes -NODES-HO
HyperV cloud Trend: Memory TREND-MEMORY-HO Trend
HyperV cloud Trend: CPU TREND-CPU-HO Trend
HyperV cloud Summary SUMMARY-V0 Summary
HyperV cloud Clusters CLUSTERS-TO Tabular
HyperV cloud Host Node Status HOST-NODE-STATUS-TO0 Tabular
HyperV cloud Host Node Inventory HOST-NODE-INVENTORY-TO Tabular
HyperV cloud VMs VMS-TO Tabular
HyperV cloud Deleted VMs DELETED-VMS-TO0 Tabular
HyperV cloud Data Stores DATA-STORES-TO Tabular
HyperV cloud Images IMAGES-T9999 Tabular
HyperV cloud Memory MEMORY-S0 Bar Chart
HyperV cloud CPU CPU-S0 Bar Chart
HyperV cloud Disk DISK-S0 Bar Chart
HyperV cluster Summary SUMMARY-V0 Summary
HyperV cluster Host Node Status HOST-NODE-STATUS-TO0 Tabular
HyperV cluster Host Node Inventory HOST-NODE-INVENTORY-TO Tabular
HyperV cluster VMs VMS-TO Tabular
HyperV cluster Events EVENTS-TO Tabular
HyperV hostnode |CPU Usage CPU-USAGE-S0 Bar Chart
HyperV hostnode |CPU Usage(Mhz) CPU-USAGE(MHZ)-S0 Bar Chart
HyperV hostnode | Memory Usage MEMORY-USAGE-S0 Bar Chart
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CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF
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IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT
LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display output, network
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